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About

You can share this PDF with anyone you feel could benefit from it, downloaded the latest version 
from: sublimetext3

It is an unofficial and free sublimetext3 ebook created for educational purposes. All the content is 
extracted from Stack Overflow Documentation, which is written by many hardworking individuals at 
Stack Overflow. It is neither affiliated with Stack Overflow nor official sublimetext3.

The content is released under Creative Commons BY-SA, and the list of contributors to each 
chapter are provided in the credits section at the end of this book. Images may be copyright of 
their respective owners unless otherwise specified. All trademarks and registered trademarks are 
the property of their respective company owners.

Use the content presented in this book at your own risk; it is not guaranteed to be correct nor 
accurate, please send your feedback and corrections to info@zzzprojects.com
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Chapter 1: Getting started with sublimetext3

Remarks

Sublime Text is a sophisticated text editor for code, markup and prose. It has a Python application 
programming interface (API). It supports many programming languages and markup languages, 
and its functionality can be extended by users with plugins, typically community-built and 
maintained under free-software licenses.

Sublime Text 3 is currently in beta. The latest build is 3114.

ST3 runs on the following operating systems:

OS X (10.7 or later is required)•
Windows 32 bit - also available as a portable version•
Windows 64 bit - also available as a portable version•
Ubuntu 32 bit - also available as a tarball for other Linux distributions.•
Ubuntu 64 bit - also available as a tarball for other Linux distributions.•

Sublime Text may be downloaded and evaluated for free, however a license must be purchased 
for continued use. There is currently no enforced time limit for the evaluation.

Build 3103 (released Feb 2016) was the first build available to everyone with the new syntax 
definition format, .sublime-syntax. This allows for richer syntax highlighting and better performance 
compared to the legacy .tmLanguage format. 3103 also features a custom regex engine that 
significantly speeds up file loading and indexing.

Examples

Installation or Setup

Please note that continued use of Sublime Text requires that you purchase a license and you are 
asked to note the terms and conditions.

The process of installing Sublime Text is different for each platform, but in each case you need to 
visit the download page.

After installing ST3, it is common to install the package manager, Package Control.

Mac

For Mac, there is only one version of Sublime Text for OS X.

Download .dmg file1. 
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Open .dmg file2. 

Drag the Sublime Text 3 bundle into the Applications folde3. 

To create a symbolic link to use at the command line issue the following command at the 
terminal:

ln -s "/Applications/Sublime Text.app/Contents/SharedSupport/bin/subl" /usr/local/bin/subl

4. 

Windows

For Windows, both 64-bit and 32-bit versions are available, portable and non-portable. You 
should be able to run the 64-bit version if you are using a modern version of Windows. If you are 
having trouble running the 64-bit version, try the 32-bit version.

Portable or Not Portable? Sublime Text comes in two flavors for Windows: normal, and portable. 
Most users should be better served by a normal installation. Use the portable version only if you 
know you need it.

Normal installations separate data between two folders: the installation folder proper, and the data 
directory (user-specific directory for data). Normal installations also integrate Sublime Text with 
Windows Explorer's context menu.

Portable installations keep all files needed by Sublime Text in a single folder. This folder can be 
moved around and the editor will still work.

How to Install the Normal Version of Sublime Text

Download the installer1. 
Double click on the installer2. 

How to Install the Portable Version of Sublime Text

Download the compressed files1. 

Unzip them to a folder of your choice2. 

You will find the sublime_text.exe executable inside that folder.

Linux

For Linux, run this command in your terminal to check your operating system’s type:

uname -m
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You can download the package and uncompress it manually. Alternatively, you can use the 
command line.

Ubuntu

For i386

cd ~ 
wget http://c758482.r82.cf2.rackcdn.com/sublime-text_build-3083_i386.deb

•

For x64

cd ~ 
wget http://c758482.r82.cf2.rackcdn.com/sublime-text_build-3083_amd64.deb

•

Other Linux Distributions

For i386

cd ~ 
wget http://c758482.r82.cf2.rackcdn.com/sublime_text_3_build_3083_x32.tar.bz2 
tar vxjf sublime_text_3_build_3083_x32.tar.bz2

•

For x64

cd ~ 
wget http://c758482.r82.cf2.rackcdn.com/sublime_text_3_build_3083_x64.tar.bz2 
tar vxjf sublime_text_3_build_3083_x64.tar.bz2

•

Now we should move the uncompressed files to an appropriate location.

sudo mv Sublime\ Text\ 3 /opt/ 
Lastly, we create a symbolic link to use at the command line. 
 
sudo ln -s /opt/Sublime\ Text\ 3/sublime_text /usr/bin/sublime

In Ubuntu, if you also want to add Sublime Text to the Unity launcher, do the following:

First, create a new file.

sudo sublime /usr/share/applications/sublime.desktop

Copy the following into it.

[Desktop Entry] 
Version=1.0 
Name=Sublime Text 3 
# Only KDE 4 seems to use GenericName, so we reuse the KDE strings. 
# From Ubuntu's language-pack-kde-XX-base packages, version 9.04-20090413. 
GenericName=Text Editor 
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Exec=sublime 
Terminal=false 
Icon=/opt/Sublime Text 3/Icon/48x48/sublime_text.png 
Type=Application 
Categories=TextEditor;IDE;Development 
X-Ayatana-Desktop-Shortcuts=NewWindow 
 
[NewWindow Shortcut Group] 
Name=New Window 
Exec=sublime -n 
TargetEnvironment=Unity

If you’ve registered your copy of Sublime Text, but every time you open it you’re asked to enter 
your license, you should try running this command.

sudo chown -R username:username /home/username/.config /sublime-text-3

Replace username with your account’s username. This should fix the permission error in the case 
that you opened up Sublime Text as root when you first entered the license.

Reference

Start with the Sublime Tutor

This tutorial is inspired from classic vimtutor. You will get to learn some handy shortcuts to work 
with Sublime Text 3. By the end of this tutorial, you would be familiar with ST's most important and 
frequently used shortcuts and features.

Installation

Via Package Control:

Install Package Control if already not installed: https://packagecontrol.io/installation#st31. 
Press Cmd+Shift+P to bring command palette in front2. 
Type Install Package and press enter.3. 
Search for Sublime Tutor and press enter to install the plugin.4. 

Manual Installation:

Make sure you have [git][1] already installed.1. 
cd into the Packages directory of Sublime Text 3. On Mac, it usually resides at the following 
path: ~/Library/Application Support/Sublime Text 3 /Packages/. Alternatively you can open in 
via a menu item: Preferences > Browse Packages...

2. 

Once you are inside Packages directory, clone this repository: git clone 
git@github.org:jai/sublimetutor.git. Alternatively download and extract the latest release for 
your platform here: https://github.com/jaipandya/SublimeTutor/releases

3. 

Restart Sublime Text4. 
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Getting Started

If you haven't already, install Sublime Tutor using the installation steps given above.

Once Sublime Tutor is installed, press Ctrl+Option+K keyboard shortcut to open this file in Sublime 
Text. Another option is to go to Help > Sublime Tutor menu option to open this.

Via Command Palette:

Cmd+Shift+P to get the command palette in front.1. 
Type Sublime Tutor, select the first command that comes up to start the interactive guide.2. 

Source:

https://sublimetutor.com/1. 
https://github.com/jaipandya/SublimeTutor2. 
https://packagecontrol.io/packages/Sublime%20Tutor3. 

Read Getting started with sublimetext3 online: 
https://riptutorial.com/sublimetext3/topic/4969/getting-started-with-sublimetext3
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Chapter 2: Build Systems

Syntax

Build Systems are written in JSON, and have the file extension .sublime-build.•

Remarks

Build Systems are output-only, meaning it is not possible to execute some code that will request 
user input using the build system. The code will just block waiting for input forever. To work around 
this, many people use a REPL plugin.

JSON keys:

shell_cmd specifies the exact command to run in the shell, and has support for variable 
placeholders (like ${file} that refers to the currently open file).

•

result_file_regex and result_line_regex are used to parse the output from a failed build and 
show the errors in such a way that it is possible to navigate the editor to where an error 
occurred.

•

selector is a scope selector that defines what syntax the build is relevant for. There's no 
point running a Python interpreter on PHP code, for example.

•

variants can be used to allow a different command to be run, for example to just check the 
syntax of the file rather than execute it. The variants can also specify or override the same 
JSON keys, and they will apply only to that variant.

•

syntax is used to set the syntax definition file which will be applied to the output panel, thus 
giving it syntax highlighting.

•

Examples

Example Build System

New build systems can be created from the menu (Tools | Build System | New Build System).

{ 
    "shell_cmd": "somecommand -u \"$file\"", 
    "result_file_regex": "^[ ]*File \"(.*?)\"", 
    "result_line_regex": "^[ ]*File \".*?\", line ([0-9]*)", 
 
    "selector": "text.html", 
    "syntax": "Packages/JavaScript/JSON.sublime-syntax", 
 
    "env": {"ENCODING": "utf-8"}, 
    "working_dir": "${project_path:${folder}}", 
    "path": "C:\\test\\;$PATH" 
 
    "linux": { 
        "variants": 
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        [ 
            { 
                "name": "Word Count (current file)", 
                "cmd": ["wc", "$file"] 
            } 
        ] 
    } 
}

A build can be initiated by using the menu (Tools | Build) or by pressing Ctrl+B.

Read Build Systems online: https://riptutorial.com/sublimetext3/topic/5073/build-systems
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Chapter 3: Essential Packages

Examples

What's in my ST (Sublime Text)

Package Control - Download/Install this plugin to install and manage all your other plugins in 
sublime.

1. 

Git - Keeps track of your git versioning system. Also enables you to execute some git 
commands from ST itself.

2. 

GitGutter - With GitGutter, you can see which lines have been added, deleted or modified in 
the gutter.

3. 

Emmet - Emmet is a useful plugin that saves time by making you write less, thus increasing 
your productivity.

4. 

AllAutocomplete - Sublime Text’s default autocomplete considers words that are present in 
the current file only. The AllAutocomplete plug-in, however, searches all open files to find 
matches while suggesting words.

5. 

Alignment - A very simple and easy to use plugin. It helps tons when you revisit the code 
later down the road. Highlight the lines you want to align and press ctrl + alt + a .

6. 

BracketHighlighter - This plugin provides bracket highlighting for all sorts of brackets in 
gutter.

7. 

Material-Theme - This theme brings the Material Design visual language to your Sublime 
Text 3.

8. 

SublimeLinter - With this your code can be linted as you type (before saving your changes) 
and any errors are highlighted immediately.

9. 

Happy Coding :)

For Terminal Prowess & Power Users

Sublime Terminal. Terminal allows use to open your favourite terminal right at the current file 
or project location you are currently working on in Sublime Text, with handy keyboard 
shortcuts. It is available through Package Control.

•

SideBar Enhancements. This plugin adds additional functionality to the Sublime Text 
SideBar like options for Cut, Copy and Paste files and folders, move them to Trash or 
Delete them entirely.

•

FileManager An alternative to SideBarEnhancements. Only provides features that you use 
everyday, and those feature are optimized at 100% (auto completion, nested creation, file 
browser, etc)

•

ReadmePlease

Package Control•
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GitHub Repo•

Open whichever package's README. Compatible with both ST2 and ST3

Read Essential Packages online: https://riptutorial.com/sublimetext3/topic/7037/essential-
packages
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Chapter 4: How to install Sublime 3 on 
CentOS 7 / RHEL 7?

Examples

Here are the steps:

Step 1: Download Sublime: You can either download from their website or use the wget as I did:

$ cd ~/Downloads 
## On 32bit 
$ wget https://download.sublimetext.com/sublime_text_3_build_3126_x32.tar.bz2 
 
## On 64bit 
$ wget https://download.sublimetext.com/sublime_text_3_build_3126_x64.tar.bz2

Step 2. Extract Sublime package (example to /opt directory) You can store Sublime at any 
place you want. Here, I saved under /opt directory.

## On 32bit 
$ sudo tar -vxjf sublime_text_3_build_3126_x32.tar.bz2 -C /opt 
## On 64bit 
$ sudo tar -vxjf sublime_text_3_build_3126_x64.tar.bz2 -C /opt

Step 3. Now, let’s make a symbolic link to the installed Sublime3 so that we can run the 
same from command line

# sudo ln -s /opt/sublime_text_3/sublime_text /usr/bin/sublime3

Step 4. Now, let’s test whether the Sublime3 is installed correctly or not. Type sublime3 in 
command line and it will open up the sublime window.

$ sublime3

Step 5. Create Gnome desktop launcher You can run Sublime3 on desktop by clicking a icon.

$ sudo sublime3 /usr/share/applications/sublime3.desktop

Step 6. Append this and close file.

[Desktop Entry] 
Name=Sublime3 
Exec=sublime3 
Terminal=false 
Icon=/opt/sublime_text_3/Icon/48x48/sublime-text.png 
Type=Application 
Categories=TextEditor;IDE;Development 
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X-Ayatana-Desktop-Shortcuts=NewWindow 
 
[NewWindow Shortcut Group] 
Name=New Window 
Exec=sublime -n 
TargetEnvironment=Unity

Now, you can see the Sublime3 icon on under Applications → Programming. You can run 
Sublime3 on desktop by clicking this icon. Enjoy!!

Read How to install Sublime 3 on CentOS 7 / RHEL 7? online: 
https://riptutorial.com/sublimetext3/topic/10678/how-to-install-sublime-3-on-centos-7---rhel-7-
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Chapter 5: Keybindings

Introduction

Keybindings are, as a lot of things in Sublime Text, JSON. Make sure you understand how to use 
them, they're going to save you a lot of time!

Syntax

keys: [list] a list of keystroke to press•
command: [string] the command to run•
args: [dict] the argument to pass to the command•
context: [list] a list of checker that will tell if the shortcut is enabled•

Remarks

Shortcuts have to be stored in a file called Default.sublime-keymap to be taken into account by 
Sublime Text.

Platform specific

What if I want to create some shortcuts only for OSX for example?

Well, you can. Just add (<platform>) after the Default. Here are the 3 possibilities:

Default (Windows).sublime-keymap•
Default (Linux).sublime-keymap•
Default (OSX).sublime-keymap•

Examples

Basic shortcut

Here is a simple shortcut that runs the command upper_case when you press ctrl+u.

{ 
    "keys": ["ctrl+u"], 
    "command": "upper_case" 
}

I've set the content of my keybindings like this, but it doesn't work!

It's normal! It's because it has to be a list of object (you probably want more than one shortcut, 
right?). Here's how it should look like:
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[ 
    { 
        "keys": ["ctrl+u"], 
        "command": "upper_case" 
    } 
]

Now it works!

Read Keybindings online: https://riptutorial.com/sublimetext3/topic/9512/keybindings
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Chapter 6: List of Shortcuts for Sublime Text 
3

Introduction

This is a list of commonly-used shortcuts in Sublime Text version 3. If you know of others, feel free 
to suggest an edit but I'll start it with [Windows] ones I know. There is a list of shortcuts in the 
sublime text docs (at http://docs.sublimetext.info/en/latest/reference/keyboard_shortcuts_win.html) 
however there is a note at the top of the page that some may not work [To my knowledge, the 
ones listed here work!]. Note also that the link links to OSX page.

Examples

Windows Shortcuts

General Description

CTRL + ` Show Hide Console

CTRL + K or CTRL + B Show/Hide Sidebar

CTRL + SHIFT + P Command Pallette

CTRL + SPACE Select 'autocomplete' suggestion

CTRL + Y Redo last keyboard shortcut

Selecting Text Shortcut Action

CTRL + D Selects a word/ used for 'select next iteration'

CTRL + U Deselect next iteration

CTRL + L Selects a line

CTRL + SHIFT + J Indent Content

CTRL + ALT + UP Column select upwards

CTRL + ALT + DOWN Column select downwards

Windows Control Windows Control

F11 Fullscreen

SHIFT + F11 Distraction-free mode
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Windows Control Windows Control

CTRL + N New Tab

CTRL +SHIFT + N New Window

CTRL + W Close Tab

ALT + (tab no) Switch Tab

CTRL + PGUP Go to Previous Tab

CTRL + PGDOWN Go to Next Tab

CTRL + (pane no) Switch to Pane Number

CTRL + SHIFT + (pane no) Move tab to pane Number

Find & Replace Description

CTRL + F Find

F3 Find Next

SHIFT + F3 Find Previous

CTRL + H Replace

CTRL + SHIFT + F Find in Files

Typography Description

CTRL + K Or CTRL + U Convert To Uppercase

CTRL + K Or CTRL + L Convert To Lowercase

CTRL + PLUS(+) Increase font size

CTRL + MINUS(-) Decrease font size

Bookmarks Description

CTRL + F2 Create a new Bookmark

F2 Go to next bookmark

SHIFT + F2 Go to Previous Bookmark

CTRL + SHIFT + F2 Clear all bookmarks

Read List of Shortcuts for Sublime Text 3 online: 
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https://riptutorial.com/sublimetext3/topic/9717/list-of-shortcuts-for-sublime-text-3
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Chapter 7: Package Control

Introduction

Package Control is a full-featured package manager that helps discovering, installing, updating 
and removing packages for Sublime Text.

Remarks

Package Control is the Sublime Text package manager. It includes a list of over 2,500 packages 
available for install, and users can add any GitHub or BitBucket repository themselves. Once 
installed, packages are kept up-to-date automatically.

The example code creates the Installed Packages folder for you (if necessary), and then 
downloads the Package Control.sublime-package into it. The download will be done over HTTP 
instead of HTTPS due to Python standard library limitations, however the file will be validated 
using SHA-256.

Examples

Installing Package Control

If you are using Sublime Text 3 then the simplest way to install Package Control is to select 
Install Package Control in the Tools menu or in the Command Palette and Sublime Text will install it 
automatically.

Manually Installing:

For Sublime Text 2, older versions of Sublime Text 3, or if you have a proxy server related 
problem, then Package Control can be installed using a Python script that must be pasted into the 
Sublime Text console.

Open the Package Control Installation Web Page in your web browser.•
Click on the Sublime Text version you require.•
Copy the Python script into your clipboard.•
Open the Sublime Text console by selecting the Show Console in the View menu, or by using 
the Ctrl+` shortcut keys, or by selecting Console: Show in the Command Palette.

•

Paste the Python script into the console and press the Enter key to run the script.•
It will take a few seconds to install but once it has been a new Sublime Text buffer will be 
displayed with information about Package Control.

•

You can new go to the Package Control Web Site and choose the packages that you want to 
install.
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Customizing sublime text

Once you have package control installed, it is super easy to install any plugin, theme, color 
scheme, syntax that you want!

plugin: perform an action (compile your less code into css for example)•
theme: change the entire skin of sublime text (tabs, sidebar, command palette, etc)•
color scheme: change the color of your code•
syntax: define how code should be highlighted.•

How do I find a package

You can search for packages on this website: packagecontrol.io, or simply search for some key 
words when you decide you need to install a package (see below).

Once I choose which package I want to install, how do I 
install it?

From ST, bring up the command palette, and type install package until package control: install 
package is hightlighted, and press enter.

Wait a bit, and a list with all the package available will come up. Type the name of the one you 
want to install, and it enter. Done!

Note: It is safe to restart sublime text after you've install a package. But it become less and less 
useful (sublime text gets better, so you almost don't need to now). So, just restart it if something is 
weird, not just because I said it.

Installing an unlisted package

By unlisted package, I mean a package that is not available through Package Control (yet). So, 
you can't find it in packagecontrol.io.

BUT, you can still install it using Package Control, so you'll get all the advantages. For example, 
they'll be automatically updated, just like a "regular" installation.

And it's really easy.

Find your package repository (it'll often be on GitHub, but you can use a BitBucket one) and 
copy the URL.

•

Search for Package Control: Add repository in the command palette (ctrl+shift+p)•
Paste the URL•
Hit enter•

And now, it's just like if this package was on the default channel (a channel is a simple list of 
packages. The default one is the one you get... by default ).
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Search for Package Control: Install Package in the command palette (ctrl+shift+p)•
(you might need to wait a few secs) Search for the package you want to install•
Hit enter!•

That's it! Pretty cool, huh? So, if you're a package developer don't hesitate to let them know they 
can do it this way (always better than the git clone and git pull ).

Note: Feel free to copy/paste this text in your readme, or adapt your own version!

Read Package Control online: https://riptutorial.com/sublimetext3/topic/6336/package-control
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Chapter 8: Vocabulary

Introduction

This is a really small part, but still essential if you want to be able to communicate efficiently with 
other people using Sublime Text 3.

More to come: settings, keymap, mousemap etc...

Examples

Themes

A theme changes the global skin of Sublime Text 3. It changes the tabs, side bar, quick panels 
(goto, command palette), status bar, etc...

Here's a non-exhaustive list of themes (top 100):

Predawn•
Material Theme•
Theme - Spacegray•
Seti_UI•
Theme - Brogrammer•
Theme - Flatland•
Theme - Soda•

Note: the convention for the theme packages name is that they start with Theme -.

Theme - Focus 
    img/ 
    focus.light.sublime-theme 
    focus.dark.sublime-theme

As you can see, this convention isn't really respected.

The themes are defined in a .sublime-theme file.

Color Schemes

The color schemes changes the colors of the code. They can change, for example, with which 
color the keywords are highlighted, with which color the line the caret is on is highlighted (needs 
highlight_line to be set to true in the preferences (not part of the cojor scheme)), what is the color 
of the caret, etc.

Many themes come with color schemes, or many packages contain plenty of them.

needs example of packages
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The color scheme are defined in a .tmTheme file. This is an XML file in the Property List format, 
which is used by many text editors.

The convention for the color schemes packages name is that they start with Color Scheme -

Color Scheme - Focus 
    first.tmTheme 
    second.tmTheme 
    ...

Tools

you can use this web app to create/edit your color schemes: tmTheme editor.•
An other tool is ColorSchemeEditor which allows to edit your color scheme from Sublime 
Text.

•

You can also switch very quickly of color scheme using Schemr•

Plugins

Plugins are .py files that changes the behaviour of Sublime Text 3. They are written, as you 
probably guessed, in Python.

Because there is plenty of different sort of plugins (text manipulation, linting, formatting, preview, 
etc), we will not give any example to not over populate this page with a huge list. Have a look at 
the Package Control browsing page if you're interested in optimising your workflow with some 
plugins (you should be).

Packages

A package is a folder that can contain anything that is listed in these examples (and other thing 
that can have nothing to do with Sublime Text 3, such as a gulpfile.js if you're automating some 
tasks).

You can install any package using the create Package Control.

A .sublime-package ?

Maybe you've seen that, when you install a package using package control, you only get a 
.sublime-package in the Install Packages folder... How come you don't get the code? In fact, a 
.sublime-package is a .zip file renamed. You can extract or preview some files inside a .sublime-
package using PackageResourceViewer.

Settings

The settings, are, as many things on Sublime Text 3, simple JSON files. Though, the extension of 
the file isn't .json but .sublime-settings. As you probably understood, the settings changes how 
the packages affects Sublime Text 3. It is important to be aware of as much settings as possible to 
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optimize your workflow.

The system for most of the packages is the following: a default one, and a user one which 
overwrites the default one.

To understand the priority of the settings (which is strongly recommend), have a look at the 
unofficial-but-awesome documentation: 
http://docs.sublimetext.info/en/latest/customization/settings.html#the-settings-hierarchy

Read Vocabulary online: https://riptutorial.com/sublimetext3/topic/8716/vocabulary
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